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Frontispiece. Three-dimensional shaded-relief image of the Atlantis II Transform Valley from 32°25′S to
33°05′S and from 56°46′E to 57°20′E looking northeast (data from Dick et al., 19911). The view shows
Atlantis Bank and the location of Ocean Drilling Program Holes 735B and 1105A from across the trans-
form. The image covers an area of ~3850 km2 (28 nmi × 40 nmi) with a maximum relief of 5.7 km from
the valley floor to the crest of Atlantis Bank.

1Dick, H.J.B., Schouten, H., Meyer, P.S., Gallo, D.G., Berg, H., Tyce, R., Patriat, P., Johnson, K., Snow, J., and Fisher, A., 1991.
Bathymetric map of the Atlantis II Fracture Zone, Southwest Indian Ridge. In Von Herzen, R.P., Robinson, P.T., et al., Proc. ODP,
Sci. Results, 118: College Station, TX (Ocean Drilling Program), foldout map.
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Reference to the whole or to part of this volume should be made as follows:
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Shipboard Scientific Party, 1999. Leg 176 Summary. In Dick, H.J.B., Natland, J.H., Miller, D.J., et al., 
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 

printing date, is the correct one.

The printing date of this volume: June 1999

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volumes 174A/174AX/174B (Initial Reports): November 1998
Volume 175 (Initial Reports): November 1998
Volume 177 (Initial Reports): May 1999
Volumes 159/159T (Scientific Results): October 1998
Volume 160 (Scientific Results): September 1998
Volume 161 (Scientific Results): February 1999

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, 1000 Discovery Drive, College Station, TX 77845-9547, U.S.A. See the ODP publication list 
at www-odp.tamu.edu/publications or contact ODP for prices and ordering information. Orders for 
copies require advance payment.

http://www-odp.tamu.edu/publications/


6

PUBLISHER’S NOTES
This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 

the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada (Canada), National Taiwan University in Taipei, and Korean 
Institute for Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Italy, The 
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, and Turkey)

Institut Français de Recherche pour l’Exploitation de la Mer (France)

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

Any opinions, findings, conclusions, or recommendations expressed in this publication are those of the 
author(s) and do not necessarily reflect the views of the National Science Foundation, the participating 
agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M Research 
Foundation.
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Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College 

Station, TX 77845-9547, U.S.A. (e-mail: database@odp.tamu.edu).

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD in PDF format.

Beginning with Initial Reports Volume 176 and Scientific Results Volume 169, all Proceedings volumes 
will be published on CD-ROM and the World Wide Web at www-odp.tamu.edu/publications. 

Initial Reports Scientific Results
Booklet format: ISSN 0884-5883 Book: ISSN 0884-5891
CD-ROM format: ISSN 1096-2522 CD-ROM format: ISSN 1096-2514
WWW format: ISSN 1096-2158 WWW format: ISSN 1096-7451

Cover photograph of the JOIDES Resolution by ODP Photographer John Beck.

http://www-odp.tamu.edu/database
mailto:database@odp.tamu.edu
http://www-odp.tamu.edu/publications/
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 

address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains seven levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of eleven U.S. oceanographic institutions, 
serves as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, 
plans, and recommendations of the JOIDES committees through major subcontracts to Texas A&M University 
(TAMU) for science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for 
logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

James D. Watkins
Admiral, U.S. Navy (Retired)
President, Joint Oceanographic Institutions, Inc., Washington, D.C.
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OCEAN DRILLING PROGRAM*

National Science Foundation
4201 Wilson Boulevard
Arlington, VA 22230, U.S.A.
Tel: (703) 306-1581; Fax: (703) 306-0390

Web site: www.nsf.gov

MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH 
SAMPLING (JOIDES)

University of California at San Diego, Scripps 
Institution of Oceanography

Columbia University, Lamont-Doherty Earth 
Observatory

University of Hawaii, School of Ocean and Earth 
Science and Technology

University of Miami, Rosenstiel School of Marine 
and Atmospheric Science

Oregon State University, College of Oceanic and 
Atmospheric Sciences

University of Rhode Island, Graduate School of 
Oceanography

Rutgers, The State University of New Jersey, 
Institute of Marine and Coastal Sciences

Texas A&M University, College of Geosciences

University of Texas at Austin, Institute for 
Geophysics

University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

* At time of publication. See Publisher’s Notes, p. 6, for list of funding agencies at time of cruise. For an up-to-date list of
current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov
http://www.oceandrilling.org
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Australia/Canada/Chinese Taipei/Korea 
Consortium for Ocean Drilling: Department of 
Primary Industries and Energy (Australia), 
Natural Resources Canada (Canada), National 
Taiwan University in Taipei, and Korean Institute 

OCEAN DRILLING PROGRAM (ODP)
Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE 

for Geology, Mining and Minerals

European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
Iceland, Italy, The Netherlands, Norway, 
Portugal, Spain, Sweden, and Switzerland)

Federal Republic of Germany, Bundesanstalt für 
Geowissenschaften und Rohstoffe

France, Institut Français de Recherche pour 
l’Exploitation de la Mer

Japan, University of Tokyo, Ocean Research 
Institute

People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 

(JOIDES)

JOIDES Office
GEOMAR Research Center
Wischhofstrasse 1-3, Building 4
D-24148 Kiel, Federal Republic of Germany
Tel: 49 (431) 600-2821; Fax: 49 (431) 600-2847
E-mail: joides@geomar.de
Web site: www.joides.geomar.de

ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
1755 Massachusetts Avenue, NW, Suite 800
Washington, DC 20036-2102, U.S.A.
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@brook.edu
Web site: www.joi-odp.org

http://www.oceandrilling.org
mailto:joides@geomar.de
http://www.joides.geomar.de
mailto:joi@brook.edu
http://www.joi-odp.org
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ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station, TX 77845-9547, U.S.A.

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
Columbia University
P.O. Box 1000, Route 9W
Palisades, NY 10964, U.S.A.
Tel: (409) 845-2673; Fax: (409) 845-4857
E-mail: odp@odp.tamu.edu
Web site: www-odp.tamu.edu

ODP LOGGING SERVICES

Borehole Research Group
Lamont-Doherty Earth Observatory
Columbia University
P.O. Box 1000, Route 9W
Palisades, NY 10964, U.S.A.
Tel: (914) 365-8672; Fax: (914) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

Tel: (914) 365-8542; Fax: (914) 365-3159
E-mail: odp@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/databank

mailto:odp@odp.tamu.edu
http://www-odp.tamu.edu
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank
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LEG 176 PARTICIPANTS*
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Woods Hole Oceanographic Institution
360 Woods Hole Road
Mail Stop #8
Woods Hole, MA 02543
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University of Miami
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Texas A&M University
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Metamorphic Petrologist
Department of Geological Sciences
University of Michigan
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425 East University
Ann Arbor, MI 48109-1063
U.S.A.
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*Addresses at time of cruise.

mailto:hdick@whoi.edu
mailto:natland@mail.rsmas.miami.edu
mailto:jay_miller@odp.tamu.edu
mailto:jalt@umich.edu
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DEDICATION
Among the many people who contribute to 
the day-to-day and leg-to-leg success of the 

Ocean Drilling Program, some carry out their 
tasks with particular skill and distinction. With 
this publication of the Initial Reports Volume 
176, we would like to recognize one 
individual who stands out, in our estimation, 
as a friend, a gentleman, a seaman, a leader, 
and a crucial contributor, not just to our 
drilling leg, but to the Ocean Drilling 
Program as a whole.

A wall plaque on the Bridge Deck of JOIDES 
Resolution lists Captain Ed Oonk as master of 
the vessel during virtually every alternate leg 
of drilling beginning with Leg 101. Captain 
Oonk was master during both Legs 118 and 
176; thus, he served during all of the drilling 
at Site 735, which is the only deep hole in 
the lower ocean crust. Captain Oonk, his 
officers, and crew were with us from the start 
and at the end of a scientific venture that 
spanned 10 years. (Continued on next page.)
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Leg 176 was Captain Oonk’s final leg as master of JOIDES Resolution. We all enjoyed a special 
retirement celebration for him as we sailed from Site 735 to Cape Town. We were privileged to 
acknowledge his skilled seamanship, his judgment during those days of high wind and rough seas 
when it was difficult to continue drilling, the thorough safety program he supervised (including the 
boat drills when all of us, scientists included, actually learned something about how to stay alive at 

sea), and the high morale of his crew, which he promoted by word and deed. We knew we were on a 
well-managed ship, and this made all our work that much easier to accomplish.

It is fair to say, as even Captain Oonk himself might admit, that JOIDES Resolution is still afloat and that 
the Ocean Drilling Program itself persists because he and his crew knew what to do, and how to do it, 
through some desperate hours in a severe storm that suddenly trapped the vessel near the dangerous 
coast of Greenland during Leg 163. At that time the day-to-day activities and skills of a working 
captain and crew were challenged to the utmost, to the extent that survival itself hung in the balance.

However, simply from the perspective of Leg 176, we would like to acknowledge the special 
contribution that Captain Oonk made over two legs of drilling at our location in the Indian Ocean. A 
great deal of our success and certainly the quality of our time at sea can be attributed to him. He is the 
best of friends and the finest of shipmates. We shall miss his judgment, good humor, and wise counsel 
when we sail again. We are pleased and proud to be able to dedicate this Initial Reports Volume 176 to 
Captain Ed Oonk.



23

ACKNOWLEDGMENTS
The Leg 176 Shipboard Scientific Party thanks Captain Ed Oonk and the officers and crew of JOIDES 
Resolution, as well as the staff of the Ocean Drilling Program, for helping to make our deep-drilling 
venture into the lower ocean crust on the Southwest Indian Ridge a success. We especially thank 

Operations Manager Mike Storms, Drilling Superintendent Wayne Malone, and the rig-floor drilling 
crew for their efforts to make Hole 735B so deep and for recovering so much spectacular core. Both 
Wayne and Rig Superintendent Pepe Estevez made their second venture to Hole 735B during Leg 176, 
10 years after Leg 118.

We also thank the marine technical staff, headed by Laboratory Specialist Dennis Graham, who made 
it possible for nearly two dozen scientists to describe and analyze the record 866 m of rock recovered 
without tripping over themselves or anyone else. The gabbros are an unprecedented contribution to 
the scientific study of Earth’s crust, and they provide the first clear picture of the structure and 
composition of the lower ocean crust. Shipboard Curator Lorraine Southey worked unstintingly to 
properly acquire and record thousands of shipboard and shore-based samples. Three of the marine 
technical staff participated in the drilling at Hole 735B during both Legs 118 and 176. Marine Lab 
Specialist Ted “Gus” Gustafson ably made more than 200 polished thin sections for us. Yeoperson 
Michiko Hitchcox displayed her usual exemplary efficiency and good humor. Don Sims was 
instrumental in the XRF laboratory. 

The preparation of this volume was facilitated by the efforts of Editor John Scroggs, Production Editor 
Amy Brundeen, and Illustrator Coleena Burt. They were ably assisted in various capacities by Marianne 
Gorecki, Katerina Petronotis, Angeline Miller, Susan Freeman, and others. We thank them, one and all.



24

CD-ROM CONTENTS: CHAPTERS

1. Leg 176 Summary
2. Explanatory Notes

3. Site 735

4. Bathymetry of Atlantis Bank—Atlantis II Fracture Zone: Southwest Indian Ridge 
(oversized map)
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Digital images and visual core descriptions (VCDs) are included in this section.

Site 735
Visual Core Descriptions: 176-735B-89R through 126R

176-735B-127R through 155R

176-735B-156R through 180R

176-735B-181R through 210R

Thin Sections
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of some of the data tables presented in Chapter 3. A complete 
listing of the ASCII data tables can be found on the next page. 
You can access these files directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can 
configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; Windows 98 systems: 
View > Folder Options > File Types; and Windows 3.1 systems: File Manager > File > Associate.

MAC COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.
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Chapter 3, Site 735
Table T14. Magnetic susceptibility downhole for Hole 735B.
Table T15. Sample bulk and grain densities for Hole 735B.
Table T17. Thermal conductivities for samples from Hole 735B.
Table T18. Compressional velocity downhole for Hole 735B.

Table T19. Resistivity measurements for Hole 735B.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIALS
The supplementary materials are divided into two directories, APPENDIX and PHOTOMIC. 

The APPENDIX directory contains linked and independent spreadsheets of Leg 176 igneous data. For 
detailed information on the spreadsheets, see “Appendix,” p. 31, in the “Leg 176 Summary” chapter. 
For detailed information about the linked spreadsheets, see “Linked Spreadsheets,” p. 8, in the 
“Explanatory Notes” chapter. These files were created in Microsoft Excel 5.0 (.XLS extension) and 
APPENDIX
CORESUMM (Complete coring summary)
CORESUM.XLS

CURATION (Curation spreadsheets)
PIECELOG.XLS (Piece length log)
SECTNLOG.XLS (Section depth log)
TS_LOG.XLS (Thin section log)

DPTHSMTH (Depth log)
EXCOM

DEPTHS.XLA (Excel add-in function; Note: 
may not operate in all software versions.)

DEPTHS.XLS (Depth log)
MACDEPTH.XLS (Depth log with macro)

SMOOTH
SMOOTEST.XLS (Smoothing algorithm)

SMOOTH.XLA (Excel add-in function; Note: 
may not operate in all software versions.)

SMOOTH.XLS (Smoothing algorithm)
IGNEOUS (Lithology and contact reference log)
README.TXT
176GEOCH.XLS (Chemical compositions)
I_COMM.XLS (Igneous comment log)
I_LITH.XLS (Igneous lithology log)
I_MIN.XLS (Mineral log)
I_OPAQUE.XLS (Oxide log)
I_TEX.XLS (Mineral texture log)
I_VEIN.XLS (Igneous vein log)

METAMORP (Metamorphic petrology 
spreadsheets)
BGALTLOG.XLS (Alteration log)

ASCII (.TXT extension).

The PHOTOMIC directory contains the individual photomicrographs, a photomicrograph log, a set of 
rulers, and axioscope and binocular scales. A readme file is included. These files were created in 
Microsoft Excel 5.0 (.XLS extension), Adobe Illustrator 6.0 (.AI extension), Canvas 3.5 (.CVS 
extension), and TIF format (.TIF).
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T_S_LOG.XLS (Thin section log)
VEIN%DEP.XLS (Core vein percent)
VEINLOG.XLS (Vein length log)

STRUCTUR (Sructural geology spreadsheets)
MAC_ONLY (For Macintosh users only)

app2truedip1
app2truedip-68020nofpu (Application 

PLASTIC.XLS (Crystal-plastic fabric data)
STRUCLOG.XLS (Structure log)
VEINDPTH.XLS (Vein depth data)
VEINS.XLS (Vein curatorial data)
XCUT.XLS (Cross-cutting relationships)

PHOTOMIC (Photomicrographs)
program)
app2truedip-ppc (Application program)
app2truedip.readme (Readme file)
appdip.test.in (Text document)

LtoPprog Folder
LinesToPlane (Application program)
LtoPlane.txt (WriteNow document)
LtoPtest.dat (Microsoft Word text 

document)
app2truedip1.sea (Application program)
StereoplotXL (Application program; Note: 

only works on Macs running OS version 8.1 or 
lower.)
SPRDSHTS

CPFABRIC.XLS (Crystal-plastic fabric 
curatorial data)

FAULTS.XLS (Fault curatorial data)
INTENSTY.XLS (Microfracture intensity data)
MAGMATIC.XLS (Magmatic fabric data)

README.TXT
PHOTOLOG (Photomicrograph log)
PHOT_R2.XLS
PHOT_R3.XLS
PHOT_R4.XLS
PHOT_R5.XLS
PHOT_R6.XLS
PHOT_R7.XLS
PHOT_R8.XLS

PHOTOTIF (102 individual photomicrographs)
RULERS.AI
SCALES (Axioscope and binocular scales)
AXIOSCOP

MAG100X.CVS
MAG100X.TIF
MAG10X.CVS
MAG10X.TIF
MAG1X.CVS
MAG1X.TIF
MAG20X.CVS
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MAG2P5X.CVS
MAG2P5X.TIF
MAG50X.CVS
MAG50X.TIF
MAG5X.CVS

MAG5X.TIF

BINOCULR
MAG1P2.CVS
MAG1P2.TIF
MAG1P6.CVS
MAG1P6.TIF
MAG1X.CVS
MAG1X.TIF
MAGP6X.CVS
MAGP6X.TIF
MAGP8X.CVS
MAGP8X.TIF
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CD-ROM CONTENTS: DRILLING LOCATIONS MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.
ODP Leg 176 Site Map

ODP Map (Legs 100–176)

DSDP Map (Legs 1–96)
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RELATED CD-ROM MATERIAL

LOGGING & CORE DATA 
A second CD-ROM, called Log and Core Data, was produced in conjunction with this leg. The Log and 
Core Data CD contains Leg 176 depth-shifted and processed logging data and ODP core data 
(shipboard gamma-ray attenuation porosity evaluator, index properties, magnetic susceptibility, P-
wave, and natural gamma). The logging data are provided by the Borehole Research Group at the 
Lamont-Doherty Earth Observatory (LDEO), ODP Logging Services Operator for ODP. 

The majority of the data included in this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory; Tel: (914) 365-
8672; Fax: (914) 365-3182; E-mail: borehole@ldeo.columbia.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
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Leg 176 Summary: CHAP_01.PDF

Explanatory Notes: CHAP_02.PDF

Site 735: CHAP_03.PDF

176-735B-89R through 126R: 735B_PT1.PDF

176-735B-127R through 155R: 735B_PT2.PDF

176-735B-156R through 180R: 735B_PT3.PDF

176-735B-181R through 210R: 735B_PT4.PDF

VOLUME
(Leg 176 Initial Reports volume)

ACROREAD
(Acrobat Reader 3.0 installation 
software and instructions for 
different platforms)

176IR.PDF
(Preliminary pages and table of  contents)

Site 735: CHAP_03

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAC

WIN

UNIX

DSDPMAP.PDF (DSDP map, Legs 1 through 96)

MAPS
(Drilling location maps) ODPMAP.PDF (ODP map, Legs 100 through 176)

IMAGES 

CHAPTERS
(Site chapters, figures, and 
tables)

CORES
(Visual core descriptions,
thin-section data tables, 
and digital core images)

TABLES
(Data tables in ASCII format)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the 
176 Initial Reports)

README.TXT

176_MAP.PDF (Leg 176 site map)

3.0

Bathymetry Map: CHAP_04.PDF

PHOTOMIC 
(Scanned photomicrographs)

SUPP_MAT
(Supplementary materials)

README.TXT

PHOTOLOG (Photomicrograph log)

PHOTOTIF (Individual photomicrographs)

RULERS.AI

SCALES (Axioscope and binocular scales)

Samples 9 through 253: TS_735B.PDF

101NDX.PDF through 161NDX.PDF (Index files)ODPINDEX
(Compiled Electronic Index 
of the Proceedings of the
Ocean Drilling Program)

NDX.PDX 
(Adobe Acrobat file used to enable Acrobat Search of 
the Compiled Electronic Index)

CORESUMM (Complete coring summary)

CURATION (Curation spreadsheets)

IGNEOUS (Lithology and contact reference log)

README.TXT 

APPENDIX
(Linked and independent
spreadsheets of Leg 176
igneous data)

METAMORP (Metamorphic petrology spreadsheets)

DPTHSMTH (Depth log)

STRUCTUR (Structual geology spreadsheets)

CD-ROM DIRECTORY STRUCTURE
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